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Warranty

The material contained in this docu-
ment is provided “as is,” and is sub-
ject to being changed, without notice, 
in future editions. Further, to the max-
imum extent permitted by applicable 
law, Agilent disclaims all warranties, 
either express or implied, with regard 
to this manual and any information 
contained herein, including but not 
limited to the implied warranties of 
merchantability and fitness for a par-
ticular purpose. Agilent shall not be 
liable for errors or for incidental or 
consequential damages in connection 
with the furnishing, use, or perfor-
mance of this document or of any 
information contained herein. Should 
Agilent and the user have a separate 
written agreement with warranty 
terms covering the material in this 
document that conflict with these 
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses 

The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of 
a U.S. Government prime contract or sub-
contract, Software is delivered and 
licensed as “Commercial computer soft-
ware” as defined in DFAR 252.227-7014 
(June 1995), or as a “commercial item” as 
defined in FAR 2.101(a) or as “Restricted 
computer software” as defined in FAR 
52.227-19 (June 1987) or any equivalent 
agency regulation or contract clause. Use, 
duplication or disclosure of Software is 
subject to Agilent Technologies’ standard 
commercial license terms, and non-DOD 
Departments and Agencies of the U.S. Gov-
ernment will receive no greater than 
Restricted Rights as defined in FAR 52.227-
19(c)(1-2) (June 1987). U.S. Government 
users will receive no greater than Limited 
Rights as defined in FAR 52.227-14 

(June1987) or DFAR 252.227-7015 (b)(2) 
(November 1995), as applicable in any 
technical data.

Safety Notices

 A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or the 
like that, if not correctly performed or 
adhered to, could result in personal 
injury or death. Do not proceed 
beyond a WARNING notice until the 
indicated conditions are fully 
understood and met.

A CAUTION notice denotes a hazard. It 
calls attention to an operating procedure, 
practice, or the like that, if not correctly 
performed or adhered to, could result in 
damage to the product or loss of important 
data. Do not proceed beyond a CAUTION 
notice until the indicated conditions are 
fully understood and met.

mailto:service.automation@agilent.com
mailto:orders.automation@agilent.com
mailto:documentation.automation@agilent.com
http://www.agilent.com/lifesciences/automation
http://www.chem.agilent.com/en-US/Contact-US/Pages/ContactUs.aspx
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Preface 

This preface contains the following topics:

• “About this guide” on page vi

• “Accessing Agilent Automation Solutions user information” on 
page viii
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About this guide

Who should read this guide

This user guide is for people with the following job roles:

 

What this guide covers

This guide contains the safety guidelines and the installation, setup, operation, 
and maintenance procedures for the Labware Stacker.

This guide does not provide instructions for the VWorks software or third-
party software. See the relevant user guides for these products. 

What is new in this revision
 and 

Job role Responsibilities

Installer Unpacks, installs, and tests the Stacker before it is used.

Integrator Configures hardware and writes software.

Lab manager, 
administrator, 
or technician

• Manages the automation system that contains the 
Stacker

• Develops the applications that are run on the system

• Develops training materials and standard operating 
procedures for operators

Operator Performs the daily production work on the Stacker and 
solves routine problems.

Feature and description See…

Updated the safety and regulatory 
compliance content.

“Safety guidelines” on page 1

Simplified and updated the software 
overview to reflect the latest versions.

“Software overview” on page 14

Added the labware specifications. “Laboratory requirements” on 
page 18

Updated the unpacking procedures. “Unpacking the Labware Stacker” 
on page 23

Included a description of how to add the 
Stacker device to a VWorks device file.

“Creating and editing VWorks 
device files” on page 32
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Software version

This guide documents Labware Stacker Diagnostics version 19.0.

Related guides

Use this guide in conjunction with the following:

• Automation Solutions Products General Safety Guide. Provides general 
safety information and describes potential safety hazards that you might 
encounter when using Automation Solutions products. A copy of this safety 
guide is included with your shipment.

• Stacker ActiveX Version 18 User Guide. Describes the ActiveX controls for 
the Labware Stacker.

• VWorks Automation Control Setup Guide. Explains how to define labware 
and labware classes, liquid classes, and pipetting techniques, and how to 
track and manage labware in storage.

• VWorks Automation Control User Guide. Explains how to create protocols, 
set task parameters for each device in the system, and how to run and 
monitor protocols.

For devices in a third- party system, see the relevant third- party system guides.

Related information

Updated all diagnostics procedures based 
on Labware Stacker Diagnostics 
version 19.0 and added a quick-
reference.

• “Setting up the device” on 
page 29

• “Configuring the device and 
labware” on page 51

• “Quick reference” on page 89

Added a procedure for changing the fuse. “Replacing the fuse” on page 82

Added a description of how to report 
problems.

“Reporting problems” on page 88

Feature and description See…

For more information about... See...

Accessing product user guides “Accessing Agilent Automation Solutions 
user information” on page viii

Reporting problems “Reporting problems” on page 88



Preface
Accessing Agilent Automation Solutions user information

viii Labware Stacker User Guide

Accessing Agilent Automation Solutions user information

About this topic

This topic describes the different formats of user information and explains how 
to access it for the Agilent Automation Solutions products.

Where to find user information

The Automation Solutions user information is available in the following 
locations:

• Knowledge base. The help system that contains information about all the 
Automation Solutions products is available from the Help menu within the 
VWorks software. 

• PDF files. The PDF files of the user guides are installed with the VWorks 
software and are on the software CD that is supplied with the product. A 
PDF viewer is required to open a user guide in PDF format. You can 
download a free PDF viewer from the internet. For information about using 
PDF documents, see the user documentation for the PDF viewer.

• Agilent website. You can search the online knowledge base or download the 
latest version of any PDF file from the Agilent website at www.agilent.com/
chem/askb. 

Accessing safety information

Safety information for the Automation Solutions devices appears in the 
corresponding device safety guide or user guide.

You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as 
Microsoft Internet Explorer and Mozilla Firefox.

Note: If you want to use Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). To 
do this, in Internet Explorer, open the Internet Options dialog box. Click the 
Advanced tab, locate the Security section, and select Allow active content to run in 
files on my computer.

To open the knowledge base, do one of the following:

• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows desktop, select Start > All Programs > Agilent Technologies > 
VWorks > User Guides > Knowledge Base.

http://www.agilent.com/chem/askb
http://www.agilent.com/chem/askb
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Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . 

The pointer changes to . Notice that the different icons or areas are 
highlighted as you move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

 

Item Feature

1 Navigation area. Consists of four tabs:

• Contents. Lists all the books and the table of contents of the 
books.

• Index. Displays the index entries of all of the books.

• Search. Allows you to search the Knowledge Base (all products) 
using keywords. You can narrow the search by product.

• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or 
previous topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
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Safety guidelines

This chapter contains the following topics:

• “General safety information” on page 2

• “Safety and regulatory compliance” on page 3

• “Potential hazards” on page 5
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General safety information

Before installing and using the Labware Stacker

Make sure that you are properly trained in:

• General laboratory safety

• The correct and safe operation of the Labware Stacker

• The correct and safe operation of lab automation systems or components 
used in combination with the Labware Stacker

General safety precautions

For general safety precautions, intended product use statement, and the list of 
safety labels, see the Automation Solutions Products General Safety Guide. 

Related information

For information about... See...

Safety and regulatory compliance “Safety and regulatory compliance” on 
page 3

Mechanical hazards “Mechanical moving- parts hazards” on 
page 5
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Safety and regulatory compliance

The Labware Stacker complies with the applicable EU Directives and bears the 
CE mark. See the Declaration of Conformity or Declaration of Incorporation, as 
applicable, for details. The Labware Stacker is designed to comply with the 
regulations and standards listed in the following table. 

Electromagnetic compatibility
If the Labware Stacker causes interference with radio or television reception, 
which can be determined by turning the device off and on, try one or more of 
the following measures:

• Relocate the radio or television antenna.

• Move the device away from the radio or television.

• Plug the device into a different electrical outlet, so that the device and the 
radio or television are on separate electrical circuits.

• Make sure that all peripheral devices are also certified.

• Make sure that appropriate cables are used to connect the device to 
peripheral equipment.

• Consult your equipment dealer, Agilent Technologies, or an experienced 
technician for assistance.

Changes or modifications not expressly approved by Agilent Technologies could 
void the user's authority to operate the equipment.

Sound emission declaration
Sound pressure: Lp < 70 dB according to EN ISO 779:2010.

Schalldruckpegel: Lp < 70 dB nach EN ISO 779:2010.

Regulatory Compliance Standard

EMC

European Union EMC Directive 2014/30/EU

IEC 61326- 1:2012 / EN 61326- 1:2013

Canada ICES/NMB- 001:2006

Australia/New Zealand AS/NZS CISPR 11:2011

Safety

European Union Machinery Directive 2006/42/EC

Low Voltage Directive 2014/35/EU

IEC 61010- 1:2001 / EN61010- 1:2001

IEC 61010- 2- 081:2001+A1:2003 /

EN 61010- 2- 081:2002+A1:2003

Canada CAN/CSA- C22.2 No. 61010- 1- 04

CAN/CSA- C22.2 No. 61010- 2- 081- 04

USA ANSI/UL 61010- 1:2004
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South Korean Class A EMC declaration

This equipment is Class A suitable for professional use and is for use in 
electromagnetic environments outside of the home.

Related information

For information about... See...

General precautions, intended 
product use statement, and list of 
safety labels

Automation Solutions Products 
General Safety Guide

Mechanical hazards “Mechanical moving- parts hazards” on 
page 5
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Potential hazards

About this topic

This topic describes potential hazards specific to the Labware Stacker. See the 
Automation Solutions Products General Safety Guide for potential hazards 
that are present on all the Agilent Automation Solutions products.

Mechanical moving-parts hazards

Figure Labware Stacker plate stage vertical travel

Sharp edges and pinch hazards

WARNING Keep away from the Labware Stacker while it is in motion. Not all 
circumstances can be foreseen and serious injury is possible. It is the responsibility of 
every operator to follow warnings and safety labels.

WARNING The Labware Stacker plate stage moves up and down during initialization. 
To prevent potential injury, keep away from the Labware Stacker while it is in motion. 

00029
vstack
vstack separated

WARNING Pinch hazard! Keep your fingers out of the path of the labware rack when 
you mount it on the Labware Stacker.

WARNING Use the rack handle to carry the labware rack. Do not hold a rack by the 
interior edges. The interior edges can have sharp surfaces that can cause cuts if handled 
improperly. 
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Figure Sharp surfaces on the labware racks: standard model (A), and front load model (B)

Miscellaneous

Related information

(A) (B)

WARNING To prevent potential injury, disconnect the power cord, air line, and 
communication cable before performing any service to the Labware Stacker.

For information about... See...

General precautions, intended 
product use statement, and list of 
safety labels

Automation Solutions Products 
General Safety Guide

Safety and regulatory compliance “Safety and regulatory compliance” on 
page 3
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2
Introduction

This chapter provides an overview of the Labware Stacker. The 
topics are:

• “Hardware overview” on page 8

• “Connection panel” on page 13

• “Software overview” on page 14

• “Quick start” on page 15
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Hardware overview

Introduction

The Agilent Labware Stacker is a robot- accessible microplate stacker that is 
used in lab automation systems to dispense and receive microplates from 
robotic systems. The Labware Stacker can hold deep- well and shallow- well 
microplates, tip boxes and lids. 

Main components

The following figure and table describe the main components of the Labware 
Stacker. 

Figure Labware Stacker components

00029
vstack
vstack separated

1

2

3

4

5

6

7
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Item Part Comment

1 Base The Stacker base that contains dowel pin holes and 
screw holes on the bottom surface for attaching the 
device to a prepared laboratory table.

2 Plate stage The platform that moves up and down to move 
labware between the rack and Presentation 
teachpoint, which is where a robot picks up or 
places labware on the plate stage.

3 Load/release 
button

The button that loads or releases a microplate from 
the rack. 

• Load. Moves the bottom microplate in the rack 
from the released position, resting atop the rack 
gripper, to being held by the gripper (loaded 
position).

• Release. Releases the microplate from the gripper 
hold and moves the microplate up to sit on top 
of the gripper. When the microplates are 
released, you can remove the rack.

4 Rack shelf The pneumatic shelf that provides a level surface to 
support the mounted labware rack. The air supply 
must be on and the shelf must be extended to enable 
the rack to be mounted properly. 

Each shelf has slots into which you insert the 
vertical tabs of the rack when you mount the rack 
on the device.

5 Air pressure 
regulator

The control for adjusting the pressure of the 
compressed air that is used to close the grippers.

Note: The two similar controls to the left and right 
are flow controls that affect the speed with which 
the grippers open and close. You should not need to 
adjust the flow controls.

6 Display The panel that displays a text string. For example, 
you can display a different name for each Labware 
Stacker in an automation system.

To change the display text, you can run the 
corresponding ActiveX method, or you can set the 
display text using the Labware Stacker Diagnostics 
software. The displayed text can be set during a run 
by the controlling software. For example, the VWorks 
software can specify the name of the type of labware 
that should be loaded into a Labware Stacker.

7 Labware rack The removable storage rack for the labware. You can 
remove the rack from the Labware Stacker to add, 
remove, and transport labware. See “Labware racks” 
on page 10.
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Stacker sensors

The following figure and table describe the sensors on the Labware Stacker.

Figure Sensor locations

Labware racks

The labware racks are available in three models: standard rack, top- load rack, 
and front- load rack. All the rack models have the following basic parts.

Item Name Description

1 Rack present 
sensor

The sensor that indicates if a rack is loaded on 
the Labware Stacker.

2 Plate present 
sensor

The sensor that indicates if a microplate is in the 
stacker grippers.

3 Notch sensors 
(not shown)

The two sensors on the left and right interior 
vertical surfaces next to the rack shelf. The 
sensors can detect the presence of a notch in the 
left or right corner of microplate.

1 2

3 3
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Figure Standard rack containing labware

The following figure shows a closeup view of a labware rack, with a microplate 
in the gripper. The front wall of the rack is not shown to reveal the gripper 
pads that are hidden from view.

Item Name Description

1 Carrying handle The standard rack has a polished top bar that 
can be used as a carrying handle. The top- load 
and front- load racks have fold- down carrying 
handles.

2 Tabs A pair of vertical tabs are located at the bottom 
on the rack sides. The tabs insert into the shelf 
slots on the device when you mount the rack on 
the device.

3 Stacker grippers  
(not shown)

The two horizontal protrusions (pads) on the 
inward- facing surface of each vertical tab. The 
pair of grippers hold a microplate during the 
loading, downstacking, and upstacking processes. 

When loaded, the bottom microplate is gripped 
by the grippers, holding up the rest of the stack 
of microplates. The grippers release the bottom 
microplate to the plate stage when dispensing 
microplates (downstacking). The grippers grip the 
microplate on the plate stage when receiving 
microplates from the robot (upstacking).

2, 3

1
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Figure Labware rack closeup view showing microplate held by the gripper pads

Related information

Microplate

For information about... See...

Safety guidelines “Safety guidelines” on page 1

Connectors “Connection panel” on page 13

Software “Software overview” on page 14
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Connection panel

The following figure and table describe the connection panel on the Labware 
Stacker.

Figure Connection panel

LNK
ACT

PWR

Vstack
connections
00024c

1

2

3

5

6

4

Item Part Comment

1 Air supply port Connects the Labware Stacker to a 
compressed- air source. The Labware Stacker 
uses compressed air to move components, 
such as opening and closing the grippers.

2 Ethernet port Connects the Labware Stacker to the 
controlling computer.

3 Serial port (DB- 9 
RS- 232 9- pin)

Used to install the device firmware at the 
manufacturer.

4 AC power entry Connects the power cord.

5 Power switch Turns on ( I ) and off ( O ) the device 
power.

6 Fuse panel Houses the AC inlet fuse.
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Related information

Software overview

About this topic

This topic describes the software that you use to operate the Labware Stacker.

• “Labware Stacker Diagnostics” on page 14

• “Laboratory automation software” on page 14

Labware Stacker Diagnostics 

The Labware Stacker Diagnostics software enables you to:

• Create and manage profiles. A profile specifies how the device establishes 
communication with the controlling computer.

• Diagnose problems. You can view status information and move components 
to diagnose and troubleshoot problems.

You open Labware Stacker Diagnostics from the VWorks software or by using 
the Stacker ActiveX control. 

Laboratory automation software

You can use either the VWorks software or third- party automation software to 
operate the Labware Stacker in protocol runs. If you plan to use third- party 
automation software, you use the Stacker ActiveX control to permit the 
software to interface with the device.

VWorks software
The VWorks software enables you to:

• Set up the Labware Stacker. During setup, you create a device file for the 
Labware Stacker or add the device to a device file. You use Labware 
Stacker Diagnostics to complete the device setup.

• Set up user accounts and privileges. You can set up different user 
accounts to enforce access policies. 

For information about... See...

Specifications for air supply, power, 
and fuse

“Laboratory requirements” on page 18

Connecting the communication 
cable, air line, and power cord

“Connecting the device” on page 25

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Safety guidelines “Safety guidelines” on page 1
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• Define labware. Labware definitions describe the labware you will use 
during protocol runs.

• Create protocols. Protocols determine the sequence of tasks you want to 
automate in a run. 

• Run, pause, monitor, and stop protocols. You can start, pause, monitor, 
and stop a protocol run from the controlling computer. 

Stacker ActiveX control
Instead of using the VWorks software, you can use another automation control 
software to operate the Labware Stacker in protocol runs. The Stacker ActiveX 
control allows automation software to interface with the device.

Related information

Quick start

Overall setup workflow

The following table presents the basic steps for setting up the Labware Stacker 
for operation.

For information about... See...

Setting up the VWorks software, 
including defining labware

VWorks Automation Control Setup 
Guide

Setting up the Labware Stacker “Setup workflow” on page 30

Labware Stacker Diagnostics “Quick reference” on page 89

How to use the VWorks software to 
run a protocol

VWorks Automation Control User 
Guide

Stacker ActiveX control  Stacker ActiveX User Guide

Step For this task... See...

1 Prepare the laboratory for the 
installation.

“Laboratory requirements” on 
page 18

2 Unpack the Labware Stacker. “Unpacking the Labware Stacker” 
on page 23

3 Install the Labware Stacker. • “Mounting the Labware 
Stacker” on page 24

• “Connecting the device” on 
page 25

4 Turn on the Labware Stacker. “Starting up and shutting down” on 
page 31
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Related information

5 Install the VWorks software, or 
integrate the Stacker ActiveX 
control.

One of the following:

• VWorks Automation Control 
Setup Guide

• Stacker ActiveX User Guide

6 VWorks software only. Start 
the VWorks software and log 
in.

VWorks Automation Control User 
Guide

7 VWorks software only. Add 
the Stacker device to a device 
file.

“Creating and editing VWorks 
device files” on page 32

8 Establish communication with 
the Labware Stacker.

• “Creating and editing profiles” 
on page 38

• “Initializing the Labware 
Stacker” on page 41

9 Load the labware racks. • “Filling or emptying a rack 
with labware” on page 43

• “Loading and releasing a rack” 
on page 46

10 Configure the Labware 
Stacker.

“Configuring the device and 
labware” on page 51

11 Set the robot teachpoint at the 
Labware Stacker.

Robot user documentation

12 Write and run protocols. One of the following:

• VWorks Automation Control 
User Guide

• Automation software user 
documentation

Step For this task... See...

For information about... See...

Setting up the VWorks software, 
including defining labware

VWorks Automation Control Setup 
Guide

Setting up the Labware Stacker “Setup workflow” on page 30

Labware Stacker Diagnostics “Quick reference” on page 89

How to use the VWorks software to 
run a protocol

VWorks Automation Control User 
Guide

Stacker ActiveX control  Stacker ActiveX User Guide
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Installing the Labware Stacker

This chapter describes how to install the Labware Stacker. 

IMPORTANT The procedures in this section are intended for 
personnel properly trained in the installation of such hardware.

The topics are:

• “Installation workflow” on page 18

• “Laboratory requirements” on page 18

• “Unpacking the Labware Stacker” on page 23

• “Mounting the Labware Stacker” on page 24

• “Connecting the device” on page 25
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Installation workflow

Workflow

Perform the following procedures in the order given. 

Related information

Laboratory requirements

About this topic

This topic describes the requirements for the site where you plan to install the 
Labware Stacker.

Step For this task… See…

1 Verify that the 
installation location 
meets the site 
requirements.

“Laboratory requirements” on page 18

2 Unpack the Labware 
Stacker.

“Unpacking the Labware Stacker” on 
page 23

3 Mount the Labware 
Stacker on the 
laboratory table.

“Mounting the Labware Stacker” on 
page 24

4 Connect the power, air 
supply, and computer.

“Connecting the device” on page 25

5 Install the VWorks 
software, or integrate 
the Stacker ActiveX 
control.

One of the following:

• VWorks Automation Control Setup 
Guide

• Stacker ActiveX User Guide

For information about… See…

Installing external devices External device user documentation

Setting up the Labware Stacker “Setting up the device” on page 29

Defining labware in the software VWorks Automation Control Setup 
Guide

Writing protocols in the VWorks 
software

VWorks Automation Control User 
Guide
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Laboratory space

General bench requirements
Make sure the bench for the Labware Stacker has the following:

• Proximity to power and air sources

• Enough space to accommodate the Labware Stacker, computer, and 
integrated devices

• Sufficient clearance on the back side of the Labware Stacker to access 
power, communication, and air tubing connections

• A level surface and a fixed position

• Proper height for any operator to comfortably operate the Labware Stacker

Space requirements
The following figure and table provide the dimensions of the Labware Stacker.

00029
vstack
vstack separated

68 cm

21.6 cm

19.7 cm
21.7 cm

Dimension Stacker (without rack) Labware rack (standard)

Height 21.6 cm (8.5 in) 68 cm (26.8 in)

Width 21.7 cm (8.6 in) 8.9 cm (3.5 in)

Depth 19.7 cm (7.8 in) 13.3 cm (5.25 in)

Weight 5.3 kg (11.6 lb) 2.25 kg (4.9 lb)
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Note: The rack dimensions listed are for the standard racks. The rack weight is 
for the front- loading style rack and does not include liquid- filled microplates. 
The height and weight are slightly different with different rack types. 

Electrical requirements

The Labware Stacker has the following power requirements.

Compressed air requirements

The Labware Stacker requires the use of clean, dry, compressed air to move 
pneumatic components inside the device. The compressed air can be from the 
following sources:

• Centralized source (house)

• Compressed- air cylinders

• Portable pumps

                                                        

Utility Requirement

Electrical 100–240~, 50/60 Hz

Operating AC current 1.2A/120V or 72A/240V (typical)

AC entry fuse 1 A, 250V, 5x20 mm, Slo- Blo

CAUTION Significant moisture or impurities in the air line can adversely affect the 
performance and life of the device. Using oil compressors can cause oil to leak into the device 
and void your warranty. Ensure that the air coming into the device is properly filtered from 
moisture or aerosolized impurities and from a recommended air source.

CAUTION Air pressure greater than 0.83 MPa (120 psi) can result in equipment damage. 
Ensure that the air flow rate and pressure meet the specified requirements.
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To maintain the desired air supply in the device, the Labware Stacker requires 
a source of air as follows:

The air supply port on the Labware Stacker uses 0.125- inch tubing and 
fittings. You may use an adapter to connect the 0.125- inch tubing from the air 
supply port to 0.25- inch tubing from your house air supply.

Environmental requirements

The Labware Stacker is for indoor use only. The following table lists the 
operating specifications.
 

Make sure the Labware Stacker is located away from the following:

• Heat and air conditioning ducts

• Direct sunlight
                                                        

Requirement Value

Quality Clean, dry, compressed

Flow rate and pressure 28.3 Lpm at 0.35 to 0.55 MPa (1 cfm at 50 to 
80 psi)

Requirement Value

Pollution degree 2

Installation category II

Temperature 4 to 40 °C

Humidity condition 10% to 90% RH, non- condensing

Elevation 1 to 2000 m
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Computer requirements and networking considerations

The Labware Stacker requires an Ethernet connection to the controlling 
computer. The computer configuration should include one of the following:

• One network card if the controlling computer will not be connected to your 
organization’s local area network (LAN).

• Two network cards if the controlling computer will be connected to the 
Labware Stacker LAN and to your organization’s LAN.

An Ethernet switch is required if you want to connect the Labware Stacker to 
a network that has other devices on it. 

Note: The Stacker has an RS- 232 serial port that is reserved for use by Agilent 
service personnel.

Additional computer requirements depend on the lab automation software you 
are using. 

• For VWorks software computer requirements, see the VWorks software 
release notes or the VWorks Knowledge Base at www.agilent.com/chem/
askb. 

• For third- party automation software, see the user documentation supplied 
with the product.

Acceptable microplates

The Labware Stacker is designed for labware that comply with the standards 
ANSI/SLAS 1- 2004 (R2012) through ANSI/SLAS 4- 2004 (R2012). Carefully 
evaluate any labware before use. 

Related information

WARNING Connecting the Labware Stacker to a company or general network can 
potentially cause injury. Remote computer operators might accidentally initiate an 
operation that causes the device to move unexpectedly, possibly injuring nearby lab 
personnel. Avoid connecting the device to a company or general network. Ensure that 
anyone with access to the device is trained in the potential hazards and how to avoid them.

For information about… See…

Laboratory requirements for other 
devices in the lab automation 
system or workstation

Device user documentation

Contacting technical support “Reporting problems” on page 33

Installing the Labware Stacker “Installation workflow” on page 18

Safety guidelines “Safety guidelines” on page 1

http://www.agilent.com/chem/askb
http://www.agilent.com/chem/askb
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Unpacking the Labware Stacker

Before you start

Move the shipping box to the area where you will be installing the device. 

IMPORTANT Save the packaging materials in case you need to move or ship 
the Labware Stacker.

Unpacking the shipping box 

To unpack the shipping box:

1 Open the box and remove the top foam packing insert.

2 Lift the contents out of the box and set each item carefully on the lab 
table where you want to install the device.

3 Remove the plastic bags and other packaging.

4 Inspect all items in the shipment for completeness and potential shipping 
damage. Make sure that the following items are included in the box:

• Labware Stacker 

• Power cord, country- specific

• Automation Solutions Products General Safety Guide

• VWorks ActiveX Controls Software Kit

Depending on your order, the shipment can also include the following required 
items:

• Labware rack

• Polyurethane tubing and fittings for the air supply connection

• Ethernet cables

Related information

For information about… See…

Laboratory requirements “Laboratory requirements” on page 18

Installing the Labware Stacker “Installation workflow” on page 18

Mounting the Labware Stacker “Mounting the Labware Stacker” on 
page 24

Safety guidelines “Safety guidelines” on page 1
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Mounting the Labware Stacker

Use the following procedure to mount the Labware Stacker on a stable 
laboratory table. Ensure that the Labware Stacker is mounted in such a way 
that all sides of the device are easily accessible to the user for cleaning and 
maintenance. 

Procedure

The following figure shows the three 0.25- inch dowel pin holes and four M6 
flathead screw holes on the Stacker base.

Figure Mounting hole pattern on the Stacker base 

To mount the Labware Stacker:

1 Refer to the preceding figure, and measure the table mounting holes to 
ensure that they will accommodate the pattern of dowel pins and screws 
on the Stacker base. 

2 Place three 0.25- inch dowel pins in the dowel pin holes on your tabletop.

3 Aligning the three Stacker dowel pin holes with the dowel pins on your 
tabletop, place the Labware Stacker on the tabletop, ensuring that all three 
dowel pins fit properly into each hole.

4 Install the four M6 flathead screws into each of the four screw holes. 
Ensure that the screws are completely screwed into the base.

5 Check that the Labware Stacker is firmly mounted to your tabletop.

Related information

Vstack
Base pin pattern screws
00020

2.5 in

0.500 in

1.909 in
3.500 in

3.918 in

2.5 in

2.092 in 2.092 in

For information about… See…

Laboratory requirements “Laboratory requirements” on page 18

Installing the Labware Stacker “Installation workflow” on page 18

Connecting the Labware Stacker “Connecting the device” on page 25
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Connecting the device

Before you start

• Make sure the laboratory setup requirements have been met. See 
“Laboratory requirements” on page 18.

• Ensure that the computer and Labware Stacker are turned off.

• Make sure you have the supplied Ethernet cable, power cord, and air 
connection kit, including tubing and fittings.

Connecting the air line

The following procedure is for a direct connection. If you have another 
instrument connected to the house air supply, you can use a T-connector to 
connect into the existing air tubing.

To install the compressed air line:

1 Turn off the air supply before connecting the air tubing to the Labware 
Stacker.

2 Cut the supplied 0.125- inch tubing to the required length.

3 Connect one end of the tubing to the air source.

If your air line uses a threaded port, attach the 0.125- in NPT fitting to the 
port. 

4 Plug the other end of the 0.125- inch tubing into the one- touch air- supply 
port on the Labware Stacker.

5 Test the installation by gently tugging the air tubing.

If you feel resistance, the line has been properly installed. If the tubing 
comes free, it needs to be inserted with more force.

6 Turn on the air.

The grip pressure is internally regulated to 0.28 MPa (40 psi), although it 
may be changed for particular microplate types. For details, see “Adjusting 
the grip pressure” on page 59.

WARNING  Working with open, charged air lines can result in injury. Turn off the 
compressed air line when disconnecting or reconnecting devices that use compressed air. 
Contact your facilities department or Agilent Automation Solutions Technical Support with 
questions about setting up the air line.

CAUTION Dirt in unfiltered air can build up in the Labware Stacker air valves and can 
eventually cause a malfunction. Ensure that the air supply is properly filtered for moisture and 
aerosol impurities. 

CAUTION Air pressure greater than 0.83 MPa (120 psi) can result in equipment damage. 
Ensure that the air flow rate and pressure meet the specified requirements.
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Connecting the power cord

To connect the power cord to the Labware Stacker:

1 On the Labware Stacker, ensure that the power switch is set to off ( O ).

2 Connect one end of the power cord to the AC power entry on the Labware 
Stacker.

3 Connect the other end of the power cord to an AC outlet with a grounded 
circuit.

Connecting the device to the computer

Typically, you use an Ethernet switch to connect the Labware Stacker to a 
local area network (LAN) that has other devices on it.

To connect through an Ethernet switch:
Note: If you are adding the Labware Stacker to an existing LAN, step 1 should 
already be done.

1 Connect the switch to the computer as follows:

a Connect the power cord to the switch.

b Connect one end of the Ethernet cable into any Ethernet port on the 
switch, and connect the other end of the cable to an Ethernet port on 
the computer.

2 Connect the Labware Stacker to the switch as follows:

a Connect one end of a second Ethernet cable to a port on the Ethernet 
switch.

b Connect the other end of the cable to the Ethernet port on the 
Labware Stacker.

IMPORTANT Do not use a crossover cable with an Ethernet switch. The 
switch performs the crossover function.

Note: You can connect as many devices to the network as there are Ethernet 
ports available.

About configuring the computer’s network card

If you are adding the Labware Stacker to an existing LAN, the network card 
should already be configured.

Make sure the value of the network card IP address and subnet mask are as 
follows:

• IP address: 192.168.0.1

• Subnet mask: 255.255.255.0

WARNING Connecting the Labware Stacker to a company or general network can 
potentially cause injury. Remote computer operators might accidentally initiate an 
operation that causes the device to move unexpectedly, possibly injuring nearby lab 
personnel. Avoid connecting the device to a company or general network. Ensure that 
anyone with access to the device is trained in the potential hazards and how to avoid them.
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Related information

For information about… See…

Installing the VWorks software VWorks Automation Control Setup 
Guide

Integrating the Stacker ActiveX 
control

Stacker ActiveX User Guide

How to confirm that the computer 
is communicating with the Labware 
Stacker

“Initializing the Labware Stacker” on 
page 41

Laboratory requirements “Laboratory requirements” on page 18

Installing the Labware Stacker “Installation workflow” on page 18

Loading a labware rack “Loading and releasing a rack” on 
page 46
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Setting up the device

This chapter contains the following topics:

• “Setup workflow” on page 30

• “Starting up and shutting down” on page 31

• “Creating and editing VWorks device files” on page 32

• “Opening diagnostics software” on page 36

• “Creating and editing profiles” on page 38

• “Initializing the Labware Stacker” on page 41

• “Filling or emptying a rack with labware” on page 43

• “Loading and releasing a rack” on page 46
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Setup workflow

Perform the following procedures in the order listed to set up the Labware 
Stacker.

Step Procedure See...

1 Turn on the Labware Stacker. “Starting up and shutting down” on 
page 31

2 VWorks software only. In the 
VWorks software, add the 
Stacker device to a device 
file.

“Creating and editing VWorks device 
files” on page 32

3 VWorks software only. Open 
the Labware Editor, and edit 
the labware definitions to 
include the Stacker 
parameters.

VWorks Automation Control Setup 
Guide

4 Open Labware Stacker 
Diagnostics and create a 
profile.

• “Opening diagnostics software” on 
page 36

• “Creating and editing profiles” on 
page 38

5 Initialize the Stacker profile. “Initializing the Labware Stacker” on 
page 41

6 Loading a labware rack. • “Filling or emptying a rack with 
labware” on page 43

• “Loading and releasing a rack” on 
page 46

7 Configure the Labware 
Stacker and the labware.

“Configuring the device and labware” 
on page 51

8 Set the external robot 
teachpoint for picking and 
placing labware on the plate 
stage.

User documentation for the external 
robot
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Starting up and shutting down

Starting up the Labware Stacker

To start up the Labware Stacker:

1 Verify that the air supply is turned on.

2 Turn on the computer and the monitor. Wait for the Microsoft Windows 
operating system to finish starting up.

3 At the Labware Stacker, press the power switch to the on (I) position.

4 Start the automation control software, for example, the VWorks software.

5 VWorks software only. Ensure that VWorks simulation is off. 

6 Initialize the device. 

For details, see “Initializing the Labware Stacker” on page 41.

If you have not yet created a device file or configured the device profile for 
your setup, see “Creating and editing profiles” on page 38.

Shutting down the Labware Stacker

To shut down the Labware Stacker:

1 Close the Labware Stacker Diagnostics dialog box, if applicable.

2 Exit the automation control software.

VWorks software only. In the VWorks window, select the Stacker device in 
the device tab, and then click Close selected device.

3 Shutdown the computer.

4 On the back of the Stacker, press the power switch to the off position (o).

5 Turn off the air supply to the Labware Stacker.

Related information

For more information about... See...

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Creating profiles “Creating and editing profiles” on 
page 38

Filling a rack with microplates “Filling or emptying a rack with 
labware” on page 43

Loading a rack on the Labware 
Stacker

“Loading and releasing a rack” on 
page 46
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Creating and editing VWorks device files

About this topic

This topic explains how to create a device file in the VWorks software and how 
to edit the device properties. 

If you already have a VWorks device file that you want to use, proceed to the 
following:

• “Adding a Labware Stacker to the device file” on page 33 

• “Setting the Labware Stacker device properties” on page 34

If you are using the Stacker ActiveX control to integrate with third- party 
automation control software, you can skip this topic.

Devices and device file defined

What is a device?
A device is an item in your lab automation system that has an entry in the 
VWorks software device file. A device can be a robot, an instrument, or a 
location in the system that can hold a piece of labware. 

What is a device file?
To communicate with and to control the robot and integrated devices, the 
VWorks software uses a device file that contains the following information:

• List of devices the software will communicate with and control

• Profile of each device (communication method, unique device configuration 
information)

• System- related configuration information of each device (for example, 
approach height, barcode access, and so on)

You provide the device information in the VWorks software. The device 
information is stored in a device (.dev) file that is located in a folder you 
specify when saving the file.

For detailed information about device files and associations with profiles, 
teachpoint files, and other VWorks components, see the VWorks Automation 
Control User Guide.

Creating a device file

Before you create a device file, start the VWorks software and log in. See the 
VWorks Automation Control User Guide for instructions.

To create a new device file:

1 In the VWorks window, select File > New > Device. A Device File tab appears.



33

4   Setting up the device
Creating and editing VWorks device files

Labware Stacker User Guide

2 Select File > Save to save the device file. The file name appears in the 
Device File tab.

 

Adding a Labware Stacker to the device file

To add the Labware Stacker to the device file:

1 In the Available Devices area, double- click the Labware Stacker device icon, or 
drag the icon into the Device File area.

Notice that in the Devices area, the first Labware Stacker device is labeled 
Labware Stacker- 1. If you add another Labware Stacker device, it will 
appear as Labware Stacker- 2, and so forth.

Note: If you do not see the Labware Stacker in the Available Devices list, 
check that the plugin file (.dll) is stored in the following folder: 

C:\Program Files (x86)\Agilent Technologies\VWorks\Plugins
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If you have added the plugin file in the Plugins folder and started the 
VWorks software, and still do not see the device in the Available Devices 
list, close any open device files and protocol files, and then select 
Tools > Reload Plugins.

Setting the Labware Stacker device properties

To set the Labware Stacker properties:

1 In the Labware Stacker Properties area of the device file, type or select the 
following:

2 In the Devices area, expand Labware Stacker, and then select Stacker.

3 In the Stacker Location Properties area, set the following parameters:

Property Description

Name The name of the Labware Stacker.

Profile The profile associated with the Labware Stacker 
device.

Select the desired profile from the list. If the profile 
you want does not appear in the list, or if no 
profile appears in the list, see “Creating and editing 
profiles” on page 38, and then return to this step to 
select the profile.

IMPORTANT Without the profile, you will not be 
able to establish communication with the device.

Disable The option to disable this device. Ensure that the 
check box is clear if you want to enable this device.

Parameter Description

Allow/prohibited 
labware

Permitted labware class for the selected location.

Use this field only if you want to limit the labware 
types. For details on labware classes, see the VWorks 
Automation Control Setup Guide.
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4 Select File > Save to save the device file.

Related information

BCR on south/
west/north/east 
side

The location of the barcode reader and the desired 
barcode reader device.

Use this field only if a barcode reader is installed on 
the device.

Use for deadlock 
avoidance

The option to permit the location to be used for 
deadlock avoidance.

Select Yes to permit labware to be moved to this 
location to avoid a deadlock in the system.

Select No if you do not want to move random 
labware to this location to avoid deadlock.

Door Not applicable

Stack Height Type the maximum height (mm) of the rack you are 
using. For example, type 660 if you are using a 
660- mm tall rack.

Parameter Description

For more information about... See...

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Creating profiles “Creating and editing profiles” on 
page 38

Using the VWorks software VWorks Automation Control User 
Guide
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Opening diagnostics software

About this topic

The Labware Stacker Diagnostics software enables you to create device profiles 
and control the motions of the Labware Stacker. The way you access 
Diagnostics depends on the automation control software that you are using:

• “Opening Diagnostics from the VWorks software” on page 36

• “Opening Diagnostics from third- party software” on page 37

Opening Diagnostics from the VWorks software

To open Labware Stacker Diagnostics:

1 In the VWorks window, ensure that the device file for your Labware Stacker 
is open.

To open the device file, choose File > Open. In the Open dialog box, select 
the *.dev file type, navigate to the device file, and then click Open.

A list of the devices appears in the Device File tab.

2 Select the Labware Stacker device, and then click Device diagnostics.
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The Labware Stacker Diagnostics dialog box opens.

Opening Diagnostics from third-party software

If you are using a different automation software, call the ShowDiagsDialog 
method to open Labware Stacker Diagnostics. For a description of the ActiveX 
methods, properties and events, see the Stacker ActiveX User Guide. 

Related information

For more information about... See...

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Creating profiles “Creating and editing profiles” on 
page 38

Using the VWorks software VWorks Automation Control User 
Guide

ActiveX controls Stacker ActiveX Version 18 User 
Guide

Labware Stacker Diagnostics 
reference

“Quick reference” on page 89
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Creating and editing profiles

About profiles

A profile is a collection of settings that manages how you connect to a device. 
The Labware Stacker profile specifies the following.

• Ethernet connection used to establish communication between the Labware 
Stacker and the controlling computer.

• The presentation height of the plate stage.

You use the Labware Stacker Diagnostics software to create and manage the 
Labware Stacker profiles.

Note: If you are using the VWorks software, be aware that each device in the 
device file requires a unique profile. 

Workflow

Use the following workflow for the Labware Stacker:

Creating a Labware Stacker profile

To create a Labware Stacker profile:

1 In the Profiles tab of Labware Stacker Diagnostics, click Create a new profile. 

Step Task See…

1 If you have not done so already, 
open Labware Stacker 
Diagnostics.

“Opening diagnostics software” 
on page 36

2 Create the Labware Stacker 
profile.

“Creating a Labware Stacker 
profile” on page 38

3 Initialize the profile to verify 
that you can establish 
communication with the Labware 
Stacker.

“Initializing the profile in 
Labware Stacker Diagnostics” on 
page 41
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Figure Labware Stacker Diagnostics Profiles tab

2 In the Create Profile dialog box that opens, type a profile name, and then 
click OK.

If you have multiple Labware Stackers in a system, ensure that you assign 
a profile name that enables you to identify each device’s profile.

3 Next to Ethernet connection, click Select Stacker.

In the Discovered BioNet Devices dialog box that appears:

a Click the Select the Ethernet adapter to use from the list below, and select the 
correct adapter for the device connection.

b In the list of devices that appear, select the Stacker device. To 
successfully communicate with the Stacker device, the Status column 
must display New or Matched.

c Click OK.
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4 Use the default value for the Stage presentation height setting. 

If necessary, you can change this position after you establish 
communication with the device. 

5 To save the profile settings, click Update this profile.

6 Verify that you can establish communication as follows:

a Click Initialize this profile.

b Ensure that the Labware Stacker initializes. 

Editing and managing profiles

Editing profiles

To edit a profile:

1 In the Profiles tab, select the profile you want to edit in the Profile 
Management area.

2 Modify the profile information.

3 When you are finished, click Update this profile to save the changes.

Managing profiles
In the Profiles tab, you can select an existing profile, and then rename, copy, or 
delete the profile.

Related information

For more information about... See...

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Configuring the Labware Stacker “Configuring the device and labware” 
on page 51

Using the VWorks software VWorks Automation Control User 
Guide

ActiveX controls Stacker ActiveX Version 18 User 
Guide

Labware Stacker Diagnostics 
reference

“Quick reference” on page 89
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Initializing the Labware Stacker 

About this topic

To establish communication between the computer and the Labware Stacker, 
you initialize the device in one of the following ways:

• Labware Stacker Diagnostics. To control the Labware Stacker using 
Diagnostics, initialize the profile in Labware Stacker Diagnostics. 

• VWorks window. To control the Labware Stacker from the VWorks window, 
for example, to run a protocol, initialize the Labware Stacker device in the 
VWorks window.

Before you start

In the VWorks window, ensure that Simulation is off.

Initializing the profile in Labware Stacker Diagnostics

To initialize a profile in Labware Stacker Diagnostics:

1 Open the Labware Stacker Diagnostics dialog box.

2 In the Profiles tab, ensure that the correct profile is selected in the Profile 
name list.

3 Click Initialize this profile.

WARNING The Labware Stacker plate stage moves up and down during initialization. 
To prevent potential injury, keep away from the Labware Stacker while it is in motion. 
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Initializing the Labware Stacker in the VWorks software

To initialize the Labware Stacker from the VWorks window:

1 In the VWorks window, choose File > Open. In the Open dialog box, select the 
*.dev file type, navigate to the device file, and then click Open.

A list of the devices appears in the Device File tab.

2 In the Devices area, select the Labware Stacker device.

3 In the Labware Stacker Properties area, make sure the correct profile is 
selected.

4 Click Initialize selected devices.

Related information

For more information about... See...

Opening Labware Stacker 
Diagnostics

“Opening diagnostics software” on 
page 36

Creating profiles “Creating and editing profiles” on 
page 38

Configuring the Labware Stacker “Configuring the device and labware” 
on page 51

Using the VWorks software VWorks Automation Control User 
Guide

ActiveX controls Stacker ActiveX Version 18 User 
Guide

Labware Stacker Diagnostics 
reference

“Quick reference” on page 89



43

4   Setting up the device
Filling or emptying a rack with labware

Labware Stacker User Guide

Filling or emptying a rack with labware

Before you start

The labware rack stores the stack of labware (microplates, tip boxes, and tube 
racks) that are processed during a protocol run. 

IMPORTANT Ensure that you position the rack so that the opening is facing 
you. Determine how the microplates should be oriented in the rack. 

The procedure can vary depending on the rack model:

• Standard or top- load racks. Place the rack on a flat, level surface. 
Although it is possible to fill or empty a mounted rack, the top of a 
mounted rack can be difficult to access safely.

• Front- load racks. The rack can be mounted on the Labware Stacker or 
placed on a flat, level surface.

Filling the standard and top-load racks

The following figure shows how to slide a stack of labware into a standard 
rack.

WARNING Make sure you understand how to handle the racks safely. See “Sharp 
edges and pinch hazards” on page 5.

WARNING  Use care to avoid sliding your hand on the interior edges in the rack. The 
edges can have sharp surfaces.
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Figure Filling a standard rack: A) Sliding the stack down through the top, B) Supporting the 
stack through the bottom slot

To put labware into a standard or top-load rack:

1 Place the rack on a flat, level surface.

2 Using both hands, carefully slide a small stack of labware down through 
the top of the rack.

You can use one hand to support underneath the labware stack, while the 
other hand holds the top of the labware to keep it level. See figure.

3 Standard racks only. When you reach the bottom of the open slot, transfer 
your hand positions so that you continue supporting the labware through 
the bottom slot. 

4 Ensure that the bottom labware in the stack rests on the rack stacker 
grippers.

To remove labware from a standard or top-load rack:

1 If possible, remove the rack from the device, and place the rack on a flat, 
level surface. 

2 Carefully slide the labware in small stacks, up and out of the top of the 
rack. 

Filling a front-load rack

The doors on the front- load rack provide easy access for placing labware into 
the front of a rack that is mounted on a device.

Stacker grippers
(inside of each tab)

A) B)
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Figure Door mechanism on the front-load rack

To place labware into a front-load rack:

1 If the rack is mounted on the Stacker device, verify that the stack is in the 
unloaded state. 

2 On each side of the rack, slide the Door- release (black) buttons forward, 
while pushing outward on the thumb tabs. The rack doors open.

Figure Opening the front-load rack

3 Place the labware directly through the open rack doors so that the bottom 
labware rests on the rack stacker grippers. Ensure the labware is level in 
the rack.

4 To close the doors, press the thumb tabs inward until the doors snap shut.

To remove labware from a front-load rack:

1 If the rack is mounted on the Stacker device, verify that the stack is in the 
unloaded state. 

2 To open the rack doors, slide the black Door- release buttons forward on 
each side of the rack, while pressing outward on the thumb tabs.

3 Carefully, lift the labware out through the front of the rack.
 

Door-release 
button

Door Door

Thumb tab

Stacker gripper
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Related information

Loading and releasing a rack

Before you start

The labware rack stores the stack of labware (microplates, tip boxes, and tube 
racks) that are processed during a protocol run. 

When you stack microplates into a rack, the bottom microplate sits on the 
rack’s stacker grippers. When you mount a rack on the Labware Stacker, the 
bottom microplate remains resting on the rack’s stacker grippers.

When you load the stack, the bottom microplate moves down and is held on 
the sides by the stacker grippers.

When you release the stack, the grippers release the microplate and the plate 
stage moves the bottom microplate up so that it sits on top of the stacker 
grippers. You can remove the rack only when the stack is released. 

Note: The Labware Stacker will not operate until the stack is loaded.
                                                        

For information about… See…

Laboratory requirements “Laboratory requirements” on page 18

Installing the Labware Stacker “Installation workflow” on page 18

Loading a rack on the Labware 
Stacker

“Loading and releasing a rack” on 
page 46

Safety guidelines “Safety guidelines” on page 1

WARNING Make sure you understand how to handle the racks safely. See “Sharp 
edges and pinch hazards” on page 5.

CAUTION Mounting a labware rack on the Labware Stacker before turning on the air 
supply can result in potential equipment damage. Ensure that the air supply is on and the 
Stacker shelves are extended before attempting to mount a rack on the Labware Stacker.

CAUTION To prevent potential equipment damage, ensure that you remove the rack from 
the Stacker before attempting to move the Labware Stacker.
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Mounting a rack and loading the stack

To mount a rack and load the stack:

1 Lower the rack onto the Stacker, positioning the rack so that the 
rectangular tabs are seated in the shelf slots of the Stacker.

Note: The rack can be oriented with the open corner at the front or 
back.

Figure Detail of rack tab above Stacker shelf slots and seated in slots

Ensure that the rack sits level on the Stacker shelf.

00029
vstack
vstack separated

00037
Vstack
locked stack top view

00038
Vstack
unlocked stack top view
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Note: The mounted rack sits on four small, round bumpers that keep it 
level, one is located on either side of each shelf. If a bumper is 
damaged or missing, contact Agilent Automation Solutions Technical 
Support.

2 To load the stack, do one of the following:

• Press the load/release button on top of the Stacker device.

• In Labware Stacker Diagnostics, click the Control tab, and then click Load 
stack.

Figure Load/release button on the Stacker device

Figure Load stack/Release stack button in the Control tab
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Releasing the stack 

To release the stack:

1 Do one of the following:

• Press the load/release button on the top of the Stacker device.

• In the Labware Stacker Diagnostics dialog box, click the Control tab, and 
then click Release stack.

2 Lift the rack up and off the Labware Stacker.

Related information

For information about… See…

Laboratory requirements “Laboratory requirements” on page 18

Installing the Labware Stacker “Installation workflow” on page 18

Filling a rack with labware “Filling or emptying a rack with 
labware” on page 43

Safety guidelines “Safety guidelines” on page 1

Labware Stacker Diagnostics • “Opening diagnostics software” on 
page 36

• “Quick reference” on page 89
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5
Configuring the device and labware

This chapter describes how to configure the Labware Stacker using 
Labware Stacker Diagnostics.

The topics are:

• “Configuration workflow” on page 52

• “Selecting the labware in diagnostics” on page 53

• “Placing a microplate on the plate stage manually” on page 57

• “Testing a microplate in the Labware Stacker” on page 58

• “Adjusting the grip pressure” on page 59

• “Adjusting the labware- specific gripper offset” on page 61

• “Setting up microplate orientation checking” on page 64

• “Changing the text in the top- panel display” on page 75

• “Changing the Presentation teachpoint” on page 77

For a description of the controls and settings in Labware Stacker 
Diagnostics, see “Quick reference” on page 89.
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Configuration workflow

Verifying your labware in the Labware Stacker

If your lab automation system is already set up and you only need to check 
that a particular labware works with a particular Labware Stacker, perform 
the following procedures.

Configuring a newly installed Labware Stacker

If this is a new installation, use the following workflow to completely configure 
the Labware Stacker.

Step For this task... See...

1 Verify that your labware is 
defined for the Labware 
Stacker.

“Selecting the labware in 
diagnostics” on page 53

2 Test your labware in the 
Labware Stacker.

“Testing a microplate in the 
Labware Stacker” on page 58

Step For this task... See...

1 Verify that your labware is 
defined for the Labware 
Stacker.

“Selecting the labware in 
diagnostics” on page 53

2 Test your labware in the 
Labware Stacker.

“Testing a microplate in the 
Labware Stacker” on page 58

3 Adjust the grip pressure “Adjusting the grip pressure” on 
page 59

4 Adjust the labware- specific 
gripper offset

“Adjusting the labware- specific 
gripper offset” on page 61

5 Configure the microplate 
orientation checking option

“Setting up microplate orientation 
checking” on page 64

6 Display a message on the 
Stacker top panel.

“Changing the text in the top- panel 
display” on page 75

7 Adjust the Presentation 
teachpoint, if necessary.

“Changing the Presentation 
teachpoint” on page 77

8 Test your labware in the 
Labware Stacker.

“Testing a microplate in the 
Labware Stacker” on page 58

http://www.chem.agilent.com/Library/usermanuals/Public/G5407-90002_R00_StackerActiveX_UG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5407-90002_R00_StackerActiveX_UG_EN.pdf
http://www.chem.agilent.com/Library/usermanuals/Public/G5407-90002_R00_StackerActiveX_UG_EN.pdf
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Selecting the labware in diagnostics

For the Labware Stacker to handle a microplate properly during diagnostics 
operations, you must select the type of microplate that you intend to use from 
the Labware list. The Labware list includes only the labware for which a 
labware definition has been created. If your labware is not in the list, see 
“Adding a labware to the list” on page 54.

The following procedures assume that Labware Stacker Diagnostics is open. For 
instructions, see “Opening diagnostics software” on page 36.

Selecting the labware

To select the labware type:
In the Labware list, select the labware type.

The Plates have lids check box is cleared and unavailable if no lid is specified in 
the labware definition. (In the Labware Editor, the Can have lid check box is 
cleared in the Plate properties tab.) Likewise, the Plates have lids check box is 
selected if the labware definition specifies that the plate properties include a 
lid.
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Adding a labware to the list

You use the VWorks Labware Editor to create and manage labware definitions. 

To open the Labware Editor:

1 In the Controls tab, click Open labware editor. The Labware Editor window 
opens.
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Figure Stacker tab in the Labware Editor window

2 Ensure that the labware definitions for the Labware Stacker define the 
following:

a Plate properties. The physical properties of the labware, such as width, 
length, and number of wells. 

You adjust these properties in the Plate properties tab of the Labware 
Editor. For instructions on how to use the Labware Editor, see the 
VWorks Automation Control Setup Guide.

b Stacker properties. The properties specific to the Labware Stacker, such 
as Gripper offset, Orientation sensor offset, Orientation sensor 
thresholds, Sensor intensity, and notch locations. 

You can adjust the Stacker properties of the labware in either of the 
following:

– Labware Editor—Stacker tab 

– Labware Stacker Diagnostics—Control tab 

Note: If you edit properties in the Labware Editor, you can re-
initialize the Labware Stacker profile to display the new values in 
Labware Stacker Diagnostics. 

Related information

For more information about... See...

Opening Labware Stacker 
Diagnostics

“Opening diagnostics software” on 
page 36
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Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Filling a rack with microplates “Filling or emptying a rack with 
labware” on page 43

Loading a rack on the Labware 
Stacker

“Loading and releasing a rack” on 
page 46

Workflow for configuring the 
Labware Stacker

“Configuration workflow” on page 52

Labware Editor VWorks Automation Control Setup 
Guide

Labware Stacker Diagnostics 
reference

“Quick reference” on page 89

For more information about... See...
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Placing a microplate on the plate stage manually

About this topic

When you are first configuring the Labware Stacker, you need to manually 
place the labware on the plate stage.

Procedure

To place a microplate on the plate stage:
Place the microplate on the plate stage so that the A1 well is at the back left 
as viewed by a plate- handling robot.

Related information

00034
Vstack
placing plate

For more information about... See...

Opening Labware Stacker 
Diagnostics

“Opening diagnostics software” on 
page 36

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Filling a rack with microplates “Filling or emptying a rack with 
labware” on page 43

Loading a rack on the Labware 
Stacker

“Loading and releasing a rack” on 
page 46

Testing microplates in the Labware 
Stacker

“Testing a microplate in the Labware 
Stacker” on page 58
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Testing a microplate in the Labware Stacker

About this topic

Use the following procedure to ensure that the labware you want to use is 
handled correctly by the Labware Stacker.

Procedure

To test a microplate in the Labware Stacker:

1 In Labware Stacker Diagnostics, click the Control tab.

2 In the Labware list, select the microplate type that you are testing. 

3 Load a labware rack filled with the selected microplates. For details, see 
“Loading and releasing a rack” on page 46.

4 Verify that the microplate downstacks properly:

a In the Control tab, click Downstack, and observe the microplate as it 
moves from the rack onto the plate stage.

b Remove the microplate from the plate stage and set it aside.

c Repeat this step as desired to verify the downstacking.

5 Verify that the microplate upstacks properly:

a Place a microplate on the plate stage.

b In the Control tab, click Upstack, and observe the microplate as it moves 
from the plate stage into the labware rack.

What to do if errors occur

If you receive errors while testing the microplate handling:

• Check the parameter settings for the labware definition. See “Adding a 
labware to the list” on page 54.

• Modify the grip pressure, if appropriate. See “Adjusting the grip pressure” 
on page 59.

Related information

For more information about... See...

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Filling a rack with microplates “Filling or emptying a rack with 
labware” on page 43

Loading a rack on the Labware 
Stacker

“Loading and releasing a rack” on 
page 46

Troubleshooting errors “Troubleshooting error messages” on 
page 84
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Adjusting the grip pressure

About the grip pressure

The Stacker air pressure regulator determines the force with which the 
Labware Stacker grips labware, also known as the grip pressure. The grip 
pressure is internally regulated to 0.28 MPa (40 psi), although it may be 
changed for particular microplate types.

When to adjust the grip pressure

The grip pressure might require adjustment to ensure that the grippers can 
grip light, flexible, or heavy microplates with the proper force:

• Light or flimsy microplates might distort when held with the default grip 
pressure of 0.24 MPa (35 psi). 

In this case, lower the grip pressure.

• If the stack of microplates in the rack is heavy, the bottom microplate 
might fall out of the gripper. For example, the stack may include many 
microplates, or the microplates might be of a heavy material and contain a 
lot of liquid. 

In this case, increase the grip pressure. 

Procedure

To adjust the grip pressure:

1 Initialize the device in Labware Stacker Diagnostics. 

2 In the Control tab, make a note of the value in the Air (psi) display.

CAUTION Setting the grip pressure less than 0.10 MPa (15 psi) can result in 
equipment damage. Ensure that you set the grip pressure greater than 0.10 MPa (15 psi).

CAUTION To prevent potential equipment damage, ensure that the grip pressure does 
not exceed the maximum air pressure specified in “Compressed air requirements” on 
page 20.
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Figure Air (psi) display in the Controls tab

3 Locate the air- pressure regulator on the Labware Stacker. Using your 
fingers or a pair of needle- nose pliers, unscrew the locking ring by turning 
it counterclockwise.

4 Adjust the grip pressure by turning the regulator. 

• Clockwise to increase the pressure (+).

• Counterclockwise to decrease the pressure (–).

IMPORTANT Do not turn the two air- flow controls to the left and right 
of the regulator.

Figure Air pressure regulator on the Labware Stacker 

+

_
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5 In the Control tab, use the Gripper controls to open and close the grippers 
three times to allow the pressure to adjust. 

6 Lock the locking ring by turning it clockwise.

Related information

Adjusting the labware-specific gripper offset 

About this topic

The Stacker gripper offset is specific to a given labware type. This property, 
which is part of the labware definition, specifies the distance below the 
standard Gripper teachpoint for the gripper to handle a given labware type. 

You can adjust this value in the following locations:

• Labware Editor—Stacker tab 

• Labware Stacker Diagnostics—Control tab

This topic describes how to adjust the gripper offset in the Labware Stacker 
Diagnostics–Control tab.

When to adjust the gripper offset

You can adjust the gripper offset if the Labware Stacker is not gripping a type 
of labware correctly.
                                                        

For more information about... See...

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Filling a rack with microplates “Filling or emptying a rack with 
labware” on page 43

Loading a rack on the Labware 
Stacker

“Loading and releasing a rack” on 
page 46

Troubleshooting errors “Troubleshooting error messages” on 
page 84
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Before you start

Ensure that you do the following.

Procedure

To change the Stacker gripper offset value in a labware definition: 

1 In Labware Stacker Diagnostics, click the Control tab.

2 Select the microplate type from the Labware list.

3 Under Operations, click Load stack, if necessary, to load the rack so that the 
bottom microplate is held by the stacker grippers.

Step For this task... See...

1 Fill the rack with at least two 
of the given labware type.

“Filling or emptying a rack with 
labware” on page 43

2 Load and lock the rack in 
place on the Labware Stacker.

“Loading and releasing a rack” on 
page 46

3 Ensure that Labware Stacker 
Diagnostics is open.

“Opening diagnostics software” on 
page 36

4 Verify a labware definition has 
been created for the labware 
type that you are using. 

“Adding a labware to the list” on 
page 54
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4 Looking through the sides and the front of the rack, visually examine the 
position of the grippers holding the microplate. 

• If the grip position is good, do not change the Stacker gripper offset 
for this labware definition. 

Ensure that the microplate is held level and is not tilted. Make sure the 
grippers are not gripping on edge of the microplate skirt.

• If the grip position requires adjustment, continue to the next step. 

Figure Labware rack closeup view showing microplate held by stacker grippers

5 Click Downstack to move the microplate out of the stacker grippers and 
onto the plate stage. 

6 With the microplate resting on the plate stage, move the plate stage to the 
desired Stacker gripper offset as follows:

a Under Move stage to, click Stacker gripper offset.

b Use the Up or Down control in the Stage Position area to adjust the 
height of the plate stage.

Microplate
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c Click Calculate next to Stacker gripper offset to change the value to the 
current location.

Note: A value greater than the original value will grip the microplate 
below the original grip point. A value lower than the original value 
will grip the microplate above the original grip point.

d Click Apply & save labware parameters to save the new value.

7 Repeat step 3 to step 6 until the grip position is correct.

Related information

Setting up microplate orientation checking

About the microplate orientation checking option

The Labware Stacker has two notch sensors that can detect the presence of a 
notch in the left or right far corners of a microplate (from the robot’s 
perspective) when a microplate is downstacked. Although the Labware Stacker 
has only two notch sensors, if a microplate with two notches is on the plate 
stage, and no notches are detected, an error message will tell you to rotate the 
microplate 180°.

Each notch sensor has an emitter that transmits light and a receiver that reads 
the amount of light reflected by the surface of the microplate. If the light beam 
bounces off a wall that is 

• Perpendicular to the light path, most of the light will reflect back. The 
resulting reading will be relatively high. 

• Not perpendicular to the light path (notched corner), the light will be 
deflected. The resulting reading will be significantly lower. 

The following figure shows the emitted and reflected light path.

For more information about... See...

Troubleshooting errors “Troubleshooting error messages” on 
page 84

Control tab reference “Labware Stacker Diagnostics—Control 
tab” on page 92
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Figure Emitted and reflected light path on notch and microplate wall with no notch (top view)

Workflow to set up microplate orientation checking

The Labware Stacker uses the following labware properties to determine 
whether a notch is present in the corresponding corner of a microplate. You 
might need to adjust one or more of these settings to optimize the orientation 
checking accuracy for your microplate type. 

• Orientation notches. The location of the notches on the microplate.

• Orientation sensor offset. The distance (mm) the plate stage will move below 
the standard Orientation sensor teachpoint to detect the microplate when 
the Check orientation option is enabled.

• Sensor intensity. The percentage of maximum sensor intensity for all sensors. 
If the sensor intensity is set too low, a microplate will not be detected even 
though one is present. If it is set too high, the sensors might become 
saturated and fail to detect the orientation of a microplate.

• Orientation sensor thresholds

– Max (notch). Specifies the highest value that an orientation sensor can 
register when sensing a notch. Any sensor reading above this value 
indicates that a solid microplate wall is present. Any sensor value 
below this threshold indicates that either a notch, or no microplate is 
present.

– Min (plate). Specifies the lowest value that a notch orientation sensor 
can register and still consider a notch to be present. A sensor reading 
below this threshold indicates that no microplate is on the plate stage.

IMPORTANT Ensure that the microplate you plan to use has notches only on 
one side of the microplate.

Refer to the following workflow and figure to set up orientation checking.

A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

Step Task See…

1 Turn on orientation checking and 
specify the notch locations for your 
microplate. 

“Turning on orientation 
checking” on page 67

2 Set the initial Orientation sensor offset 
for your microplate. 

“Calculating the initial 
Orientation sensor offset” 
on page 68
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The following figure shows the workflow to set up microplate orientation 
checking. The overall goal is to obtain notch sensor values that are widely 
separated for the left and right sides of the microplate, and an Orientation 
sensor threshold that lies roughly half way between those notch sensor values.

3 Examine the sensor readings for your 
microplate.

“Examining the sensor 
reading for your microplate” 
on page 69

4 Refer to the following figure, and if 
necessary, adjust one or more of the 
following:

• Sensor Intensity “Adjusting the sensor 
intensity” on page 70

• Orientation sensor thresholds “Adjusting the Orientation 
sensor thresholds” on 
page 71

• Orientation sensor offset “Adjusting the Orientation 
sensor offset” on page 72

Step Task See…
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Figure Workflow for setting up notch orientation checking 

Turning on orientation checking

You can turn on orientation checking in the following locations:

• Labware Editor—Stacker tab 

• Labware Stacker Diagnostics—Control tab

Use the following procedure to turn on orientation checking in the Control tab 
of Labware Stacker Diagnostics.

Turn on 
orientation 
checking.

Place microplate 
on stage and 
examine sensor 
readings.

Is difference 
between left 
and right notch 
sensors  
>100?

Are sensors 
both at their 
top limit (about 
230) or bottom 
limit (0)?

Does that 
create a 
dfference of 
>100?

Upstack and 
downstack 
microplates 
to test.

Repeat for 
each type of 
microplate on 
each Stacker.

Set the 
Orientation 
sensor 
threshold.

Adjust the
Sensor 
intensity.

Adjust the
Orientation 
sensor offset.

No

No

No

Yes

Yes Yes

Yes

Set the initial 
Orientation 
sensor offset.
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Note: If orientation checking is turned off, the plate stage still moves to the 
Orientation teachpoint during upstack and downstack operations, but the 
orientation is registered as correct regardless of the actual orientation of the 
microplate.

To turn on plate orientation checking:

1 In Labware Stacker Diagnostics, click the Control tab.

2 Select the microplate type from the Labware list.

3 Under Orientation Notches, select the Check orientation check box, and then 
select the notch check box or check boxes that correspond with the 
labware.

4 Click Apply & save labware parameters to save the change to this labware 
definition.

Calculating the initial Orientation sensor offset

The Orientation sensor offset is the height at which the orientation checking 
sensors view the microplate, with respect to the sensor.

IMPORTANT To detect notches, the Orientation sensor offset must be 
appropriate for your specific labware type. For example, a microplate might 
have an Orientation sensor offset of 8 mm, but a tip box might have an offset 
value of 42 mm.

You can calculate an initial value by taking the average of the microplate 
height plus the height of the microplate skirt: (x + y)/2 
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where x and y are the dimensions shown in the following figure.

To enter the initial plate-specific orientation sensor offset value:

1 In Labware Stacker Diagnostics, click the Control tab.

2 Select the microplate type from the Labware list.

3 In the Move stage to area, type the initial value in the Current box (mm) next 
to Orientation sensor offset.

4 Click Apply & save labware parameters to save the change to this labware 
definition.

Examining the sensor reading for your microplate

Before making further adjustments to the settings, use the following procedure 
and examine the sensor reading for your microplate.

To examine the sensor readings for your microplate:

1 Place the microplate that you are testing on the Stacker plate stage. For 
instructions, see “Placing a microplate on the plate stage manually” on 
page 57.

Ensure that the microplate has a notched corner on either the left or the 
right side closest to the Stacker device.

2 In Labware Stacker Diagnostics, ensure that the microplate type is selected in 
the Control tab Labware list.

3 In the Move stage to area, click Orientation sensor offset. The plate stage moves 
to the specified offset from the Orientation sensor teachpoint.

x
y

00034
Vstack
placing plate
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4 In the Sensors area, examine the Notch sensors readings: 

• If the sensor readings are widely separated (>100), they are detecting a 
notch on one side and a solid microplate wall on the other side. To 
verify the adjustment, upstack and downstack the microplate several 
times. See “Testing a microplate in the Labware Stacker” on page 58.

• If the sensor readings for notched and unnotched corners are similar, 
adjust the Sensor Intensity. See “Adjusting the sensor intensity” on 
page 70. 

– If both numbers are very high, reduce the Sensor Intensity.

– If both numbers are very low, increase the Sensor Intensity.

Refer to the figure under “Workflow to set up microplate orientation 
checking” on page 65 to determine what to do next.

Adjusting the sensor intensity 

When to adjust the sensor intensity
If the sensor intensity is set too low, a microplate will not be detected even 
though one is present. If it is set too high, the sensors might become saturated, 
causing failure to detect the orientation of a microplate. 

The following factors can affect the reading of the notch sensor and might 
require that you adjust the Sensor intensity value:

• Microplate position. For optimum results, the sensor light should bounce off 
of the microplate at halfway between the top of the microplate and the top 
of the microplate skirt.
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• Microplate color. White reflects light differently than black or darker colors. 
The sensor light is more sensitive to white, which emits more reflected 
light than other colors, so the sensor intensity should be lower when using 
white plates. The following table provides some guidelines for sensor 
intensity settings based on microplate color.

• Microplate material. Shiny or reflective microplates might require lower light 
intensity.

• Microplate condition. Cracks, chips, scratches, or defects in the area where 
the sensor light contacts the microplate can affect sensor reading.

• Ambient light. Brighter rooms might require lower light intensity.

Procedure

To adjust the Sensor intensity:

1 In Labware Stacker Diagnostics, ensure that the microplate type is selected in 
the Control tab Labware list.

2 In the Sensor Intensity area, type the new value, and then click Apply & save 
labware parameters.

3 Examine the sensor readings for your microplate. For details, see 
“Examining the sensor reading for your microplate” on page 69. 

Adjusting the Orientation sensor thresholds

The Orientation sensor thresholds determine what the Labware Stacker 
considers a notch. If the Labware Stacker does not observe a notch when it 
should, adjust the Orientation sensor thresholds.

When the plate stage is in the Orientation sensor position, the notch sensors 
should clearly detect a notch. 

Specifications
The sensor on the notched side of the microplate should display a negative 
(orange) number. 

The sensor on the side of the microplate with no notch should display a 
positive (white) number.

If this is not true, follow the instructions below to change the Orientation 
sensor thresholds.

To adjust the Orientation sensor thresholds:

1 In Labware Stacker Diagnostics, ensure that the corresponding microplate type 
is selected in the Control tab Labware list.

2 In the Orientation sensor thresholds area, type the following values:

• Max (notch). The highest value that an orientation sensor can register 
when sensing a notch. Any sensor reading above this value indicates 
that a solid microplate wall is present. Any sensor value below this 
threshold indicates that either a notch, or no microplate is present.

Microplate color Sensor intensity value

White <10%

Black 50%

Clear Adjust value as necessary
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• Min (plate). The lowest value that an orientation sensor can register and 
still consider a notch to be present. A value below this threshold 
indicates no microplate is present on the stage.

3 Click Apply & save labware parameters.

4 Examine the notch sensor readings for your microplate. See “Examining the 
sensor reading for your microplate” on page 69.

Adjusting the Orientation sensor offset

Before you start:

1 Remove the rack from the Labware Stacker. For instructions, see “Loading 
and releasing a rack” on page 46.

2 Ensure that the microplate has only one side with notched corners. For 
example, the following figure shows a microplate with notches on its west 
side.

A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24
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3 Place the microplate on the plate stage. For instructions, see “Placing a 
microplate on the plate stage manually” on page 57.

To adjust the plate-specific orientation sensor offset:

1 In the Control tab, select the corresponding microplate from the Labware 
list.

2 In the Move stage to area, click Orientation sensor offset.

The plate stage moves to the Orientation sensor position.

3 In the Stage Position area, click Down until the left and right Notch sensors 
both display zero.

At this point, the emitted light beam is above the microplate. 

4 Click Up until the sensor corresponding to the corner with the notch has a 
white value.

This position indicates that the top of the microplate is just aligned with 
the top of the sensor’s vertical range.

5 Write down the value displayed in the Stage Position display.

6 Continue to click Up until the values displayed for the left and right Notch 
sensors are large and white.

At this point, the light beams on both sides are hitting the top of the 
microplate skirt and reflecting back.

7 Write down the value that appears in the Stage Position display.

8 Calculate the average of the two values you recorded in steps 5 and 7.

This calculation represents the midpoint of the valid sensor range.
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9 In the Move stage to area, set the value of the Orientation sensor offset to zero, 
click Apply & save labware parameters, and then click Orientation sensor offset to 
move the plate stage to the orientation sensor teachpoint.

10 Compare the value that appears in the Stage Position display (orientation 
sensor teachpoint) with the value that you calculated in step 8.

The difference represents the plate- specific orientation sensor offset to 
achieve an optimal reading position.

11 Set the new value for Orientation sensor offset.

For example, if the Orientation sensor teachpoint stage position value is 
65 mm and the calculated value is 70 mm, enter an offset value of 5 mm.

12 Click Apply & save labware parameters.

Related information

For more information about... See...

Opening Labware Stacker 
Diagnostics

“Opening diagnostics software” on 
page 36

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Filling a rack with microplates “Filling or emptying a rack with 
labware” on page 43

Loading a rack on the Labware 
Stacker

“Loading and releasing a rack” on 
page 46

Troubleshooting errors “Troubleshooting error messages” on 
page 84

Controls in the Control tab “Labware Stacker Diagnostics—Control 
tab” on page 92
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Changing the text in the top-panel display

About this topic

This topic describes how to use Labware Stacker Diagnostics to display a text 
message in the top panel on the Stacker. 

Note: Long messages are scrolled across the display.

Figure Display on the top panel of the Stacker 

To use the ActiveX control to set the text message in the display, see the 
Stacker ActiveX Version 18 User Guide.

Procedure

To change the text in the display on the top panel:

1 Open Labware Stacker Diagnostics.

2 In the Control tab, type the new text in the Top Panel Display Message box.

3 Click Set. The message displays on the top of the device.

00029
vstack
vstack separated
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Related information

For more information about... See...

Opening Labware Stacker 
Diagnostics

“Opening diagnostics software” on 
page 36

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Filling a rack with microplates “Filling or emptying a rack with 
labware” on page 43

Loading a rack on the Labware 
Stacker

“Loading and releasing a rack” on 
page 46

Troubleshooting errors “Troubleshooting error messages” on 
page 84

Control tab reference “Labware Stacker Diagnostics—Control 
tab” on page 92
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Changing the Presentation teachpoint

About this topic

The Presentation teachpoint specifies the plate stage height (mm) above the 
home position at which a robot picks up or places a microplate on the plate 
stage.

IMPORTANT The Presentation teachpoint may be changed only if a particular 
configuration requires a value that is different from the 2.0 mm default.

IMPORTANT Do not change this value for a Labware Stacker that is used on 
a BioCel Automation System.

Procedure

To change the Presentation teachpoint:

1 Initialize the profile in Labware Stacker Diagnostics.

2 In the Control tab, under Move stage to, click Presentation. The plate stage 
moves to the Presentation teachpoint.

3 In the Stage Position area, verify that the display shows the current location 
of the Presentation teachpoint. For example, if the Presentation teachpoint 
is 2 mm, the Stage Position display should show 2 mm ±0.03.
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4 Click the Up and Down controls to move the plate stage to the desired 
Presentation teachpoint, and then record the value that appears in the 
Stage Position display.

5 Click the Profiles tab.

6 In the Stage presentation height box, type the value you recorded in step 4.

7 Click Update this profile.

Related information

For more information about... See...

Opening Labware Stacker 
Diagnostics

“Opening diagnostics software” on 
page 36

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Troubleshooting errors “Troubleshooting error messages” on 
page 84

Controls in the Control tab “Labware Stacker Diagnostics—Control 
tab” on page 92
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6
Maintaining the device

This chapter contains the following topics:

• “Routine cleaning and maintenance” on page 80

• “Replacing the fuse” on page 82

• “Troubleshooting error messages” on page 84

• “Reporting problems” on page 88

Note: The Control tab in Labware Stacker Diagnostics provides 
controls that you can use to help troubleshoot problems. For a 
description of each control, see “Labware Stacker Diagnostics—
Control tab” on page 92
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Routine cleaning and maintenance

Before you start

Routine cleaning

Clean the Labware Stacker weekly or as needed. 

To clean the Labware Stacker:

1 Use standard laboratory wipes and a mild detergent or Ethanol to clean 
the exterior painted white surfaces and the metal surfaces of dust, grime, 
chemical deposits, and other debris.

2 Remove the rack and clean the Labware Stacker in the top four corners 
and inside the shelves. Remove any pieces of cracked labware.

3 Gently, clean the sensors on the device using a soft cloth dampened with 
water. For sensor locations, see “Stacker sensors” on page 10.

4 Use a soft cloth dampened with water to clean the stacker gripper pads on 
the rack.

WARNING To prevent potential injury or equipment damage, always disconnect the 
device power, air, and Ethernet cable before performing any cleaning or maintenance.

CAUTION Use only the recommended cleaning materials. Using other cleaning solutions 
and materials can cause damage to the device. Do not use abrasive, corrosive cleaning 
agents. Do not use metal brushes.
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Figure Stacker gripper locations on front-loading rack

Periodic inspection and routine maintenance

Inspect the following components monthly, or as necessary.

Related information

Inspection task Routine maintenance 

Check the stacker gripper pads 
on the rack for dirt, damage, and 
wear.

Clean dirty or sticky gripper pads using a 
soft cloth dampened with water.

Inspect for damaged or worn gripper 
pads. For replacement, contact Agilent 
Automation Solutions Technical Support.

Verify that the labware racks are 
in good condition.

Replace warped or damaged labware 
racks.

Verify that the air- supply tubing 
is in good shape and that the 
connection has no leaks.

Replace damaged or worn tubing.

For more information about... See...

Opening Labware Stacker 
Diagnostics

“Opening diagnostics software” on 
page 36
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Replacing the fuse

Before you start

Ensure that you have the following:

• Fuse of the specified type

See “Laboratory requirements” on page 18 for the fuse specifications.

• Flathead screwdriver

Procedure

To replace the fuse in the power switch:

1 Shut down the Labware Stacker and unplug the power cable.

2 At the control panel power switch enclosure, use a small flat- head 
screwdriver (2.5 mm) to pry open the tab at the top of the enclosure and 
open the enclosure cover.

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Filling a rack with microplates “Filling or emptying a rack with 
labware” on page 43

Loading a rack on the Labware 
Stacker

“Loading and releasing a rack” on 
page 46

Diagnostics controls “Labware Stacker Diagnostics—Control 
tab” on page 92

For more information about... See...

WARNING To prevent potential injury or equipment damage, disconnect the instrument 
power, air, and communication cables before performing the following procedure.

CAUTION A blown fuse can indicate more serious problems. If the new fuse blows after 
replacement, contact Agilent Automation Solutions Technical Support.

CAUTION Use only the specified fuse type for replacement. Using an incorrect fuse can 
damage the device.
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Figure Fuse enclosure location

3 Insert the screwdriver head in the enclosure notch to dislodge the fuse 
cartridge. Slide the fuse cartridge all the way out of the enclosure.

Figure Fuse enclosure location

4 Replace the fuse in the cartridge.

5 Slide the fuse cartridge back into the fuse enclosure.

6 Press the enclosure cover securely into the closed position.

7 Reconnect the power cord.

Related information

For more information about... See...

Opening Labware Stacker 
Diagnostics

“Opening diagnostics software” on 
page 36

Initializing the Labware Stacker “Initializing the Labware Stacker” on 
page 41

Filling a rack with microplates “Filling or emptying a rack with 
labware” on page 43

Loading a rack on the Labware 
Stacker

“Loading and releasing a rack” on 
page 46
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Troubleshooting error messages

Refer to the following table to resolve common errors. If your particular issue 
is not in the table, or if the recommended steps do not solve your problem, see 
“Reporting problems” on page 88.

Note: The Control tab in Labware Stacker Diagnostics provides controls that 
you can use to help troubleshoot problems. For a description of each control, 
see “Labware Stacker Diagnostics—Control tab” on page 92.

Error Possible cause Solution

Cannot perform operation 
without first loading rack.

No rack present.

The rack is not properly 
positioned in the Stacker.

Verify that the rack is positioned 
correctly. For details, see “Loading 
and releasing a rack” on page 46.

The Rack present sensor has 
failed.

Clean the Rack present sensor using 
a soft cloth dampened with water. 

In Labware Stacker Diagnostics, 
ensure that the Rack present sensor 
reads a value greater than 20 when a 
rack is loaded. 

Could not perform operation 
with plate on stage.

A microplate is already on 
the plate stage.

Remove the microplate from the 
stage.

The sensor threshold is set 
too low.

Adjust the orientation sensor 
thresholds to appropriate values for 
the microplate type, and then retry 
the operation.

See “Setting up microplate orientation 
checking” on page 64.

One or both of the notch 
sensors has failed.

Clean the notch sensors using a soft 
cloth dampened with water.

In the Control tab, verify that values 
close to zero appear in the Notch 
sensor displays when no labware is 
present on the stage. 
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No plate on stage. The Labware Stacker failed 
to sense a plate when you 
clicked the Upstack button 
because no labware is on the 
plate stage.

Place a plate on the stage, and then 
retry the operation.

The orientation sensor 
thresholds are set too high.

Adjust the orientation sensor values. 

See “Setting up microplate orientation 
checking” on page 64.

One or both of the notch 
sensors has failed.

If the sensor intensity is set correctly, 
and the notch sensor values do not 
change when a plate is on the stage 
in the orientation sensor position, 
one or both of the notch sensors 
have failed.

Clean the notch sensors using a soft 
cloth dampened with water. Retry the 
operation.

No plate available. A rack is present (loaded or 
unloaded) but it contains no 
labware.

Fill the rack with labware.

For details, see “Filling or emptying a 
rack with labware” on page 43.

A rack is present and it 
contains labware, but it is 
not loaded at the time you 
press the Downstack button.

Load the rack.

For details, see “Loading and 
releasing a rack” on page 46.

The Labware Stacker is not 
correctly configured for your 
labware. For example, you 
are using a black microplate 
and the sensor intensity is 
set too low.

Ensure the properties in the labware 
definition are configured correctly. 
See “Setting up microplate orientation 
checking” on page 64.

The plate present sensor has 
failed.

Clean the plate present sensor using 
a soft cloth dampened with water. 
Retry the operation.

Error Possible cause Solution
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Plate is rotated 180°. The notch is not in the 
specified location because 
the microplate is rotated by 
180°.

Rotate the microplate to the specified 
position and then retry the operation.

The notch orientation 
configuration is incorrect in 
the labware definition.

Verify that the Check Orientation 
feature is configured correctly for this 
labware definition. See “Setting up 
microplate orientation checking” on 
page 64.

Note: If the problem persists and the 
run must continue, turn off 
orientation checking.

The orientation sensors are 
not configured properly.

Make sure that the Sensor Intensity 
and Orientation sensor threshold 
configurations are correct.

See “Setting up microplate orientation 
checking” on page 64.

One or both of the notch 
sensors has failed.

Clean the notch sensors using a soft 
cloth dampened with water. Retry the 
operation.

If the sensor values do not change 
with the presence or absence of a 
microplate in the orientation sensor 
position, one or more sensors may 
have failed.

Error Possible cause Solution
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Plate on stage is the wrong 
type.

The labware selection is 
incorrect.

Ensure that the labware selection in 
the software corresponds with the 
physical microplate on the stage.

The notch is not in the 
specified location because 
the microplate is rotated by 
180°.

Rotate the microplate to the specified 
position and then retry the operation.

The notch orientation 
configuration is incorrect in 
the labware definition.

Verify that the Check Orientation 
feature is configured correctly for this 
labware definition. See “Setting up 
microplate orientation checking” on 
page 64.

Note: If the problem persists and the 
run must continue, turn off 
orientation checking.

The orientation sensors are 
not configured properly.

Make sure that the Sensor Intensity 
and Orientation sensor threshold 
configurations are correct.

See “Setting up microplate orientation 
checking” on page 64.

One or both of the notch 
sensors has failed.

Clean the notch sensors using a soft 
cloth dampened with water. Retry the 
operation.

If the sensor values do not change 
with the presence or absence of a 
microplate in the orientation sensor 
position, one or more sensors may 
have failed.

Stage position error. Something is obstructing the 
plate stage and preventing it 
from reaching its 
commanded location.

Check for debris that may be blocking 
the stage.

The labware stacking 
thickness is not set correctly 
in the labware definition.

Verify that the Thickness and 
Stacking thickness properties are set 
correctly for this labware type in the 
Plate Properties tab in the Labware 
Editor.

For details, see VWorks Automation 
Control Setup Guide.

The labware is not properly 
seated on the plate stage.

Reset the labware on the plate stage, 
and then retry the operation.

A communications failure 
has occurred.

Retry the operation.

Error Possible cause Solution
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Reporting problems

Contacting Automation Solutions Technical Support 

If you find a problem with the Labware Stacker, contact Automation Solutions 
Technical Support. For contact information, see Notices on the back of the title 
page. 

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number 
of the device ready.

Reporting software problems

When you contact Automation Solutions Technical Support, make sure you 
provide the following:

• Short description of the problem

• Relevant software version number (for example, automation control 
software, diagnostics software, and firmware)

• Error message text (or screen capture of the error message dialog box)

• Relevant files, such as log files

Reporting user guide problems

If you find a problem with this user guide or have suggestions for 
improvement, send your comments in an email to 
documentation.automation@agilent.com.
 

Related information

For more information about... See...

Maintenance “Routine cleaning and maintenance” on 
page 80

Error messages “Troubleshooting error messages” on page 84

mailto:documentation.automation@agilent.com


89

Labware Stacker
User Guide



A
Quick reference

This appendix provides a quick reference of the commands, 
selections, and parameters in the Labware Stacker Diagnostics 
dialog box. 

The topics are:

• “Labware Stacker Diagnostics—Profiles tab” on page 90

• “Labware Stacker Diagnostics—Control tab” on page 92
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Labware Stacker Diagnostics—Profiles tab

Profile Management area

Command Description

Profile name Displays the selected profile. Also allows you 
to select from the list of available profiles.

Create a new profile Creates a new profile.

Create a copy of this profile Creates a duplicate copy of the selected 
profile.

Rename this profile Renames the selected profile.

Delete this profile Deletes the selected profile.

Update this profile Saves changes to the selected profile.

Initialize this profile Initiates communication with the Stacker 
using the selected profile.
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Profile Settings area

Related information

Selection or command Description

Device ID Displays the device number of the Labware 
Stacker that is communicating with the 
computer.

Ethernet connection

Select Stacker

Opens the Discovered BioNet Devices dialog 
box, which lists the connected devices that 
the software found. To successfully 
communicate with the device, the Status 
column must display New or Matched.

Stage presentation height 
(mm)

Specifies the teachpoint to which the Stacker 
plate stage moves to enable a robot to pick 
up or place a microplate at the plate stage. 

Note: This teachpoint should only be changed 
if a configuration requires a Presentation 
teachpoint that is different from the 2.00 mm 
default. For example, you might set a lower 
Stage presentation height to allow robots to 
place tall 250- µL tip boxes onto the Stacker 
plate stage.

Note: The Stacker tab in the VWorks Labware 
Editor includes a property called 
Presentation offset, which is used by the 
BioCel Automation System. For more 
information, see the VWorks Automation 
Control Setup Guide.

For more information about... See...

Opening diagnostics “Opening diagnostics software” on 
page 36

Creating a profile “Creating and editing profiles” on 
page 38

Establishing communication with 
the device

“Initializing the Labware Stacker” on 
page 41

Adjusting the Stage presentation 
height

“Changing the Presentation teachpoint” 
on page 77

Control tab “Labware Stacker Diagnostics—Control 
tab” on page 92
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Labware Stacker Diagnostics—Control tab

Labware area

Selection or command Description

Labware Specifies the type of labware that the Labware 
Stacker will handle.

Note: If your labware is not in the list, use the 
VWorks Labware Editor to create the labware 
definition and add it to the list. To start the 
Labware Editor, under Labware Settings, click Open 
labware editor.

Plates have lids Indicates that the labware selected for processing 
have lids. This property is unavailable if the labware 
definition does not specify lids. For details on how 
to specify lids in the labware definition, see the 
VWorks Automation Control Setup Guide.
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Labware Settings area

The labware properties are linked to the properties of the same names in the 
Stacker tab of the Labware Editor. Saving the changes in either location 
updates the selected labware definition.

Property or command Description

Open labware editor Starts the VWorks Labware Editor. You use the 
Labware Editor to create and manage the labware 
definitions that appear in the Labware list.

Orientation Notches • Check orientation. Turns on microplate- orientation 
checking based on the selected notch locations for 
your microplate. The notch locations are ignored 
when this check box is cleared.

• Notch location check boxes. Specifies whether a notch 
is present in the corresponding corner of the 
microplate.

IMPORTANT The Labware Stacker has only two 
orientation sensors for detecting notches. If the wrong 
microplate is loaded, the sensors will not flag an 
incorrect microplate.

Sensor Intensity % Sets the percentage of maximum sensor intensity for 
all sensors. If the sensor intensity is set too low, a 
microplate will not be detected even though one is 
present. If it is set too high, the sensors might become 
saturated and fail to detect the orientation of a 
microplate.

This parameter adjusts for the fact that clear, black, 
and white microplates reflect light differently. For 
example, white microplates generally reflect more light 
so the sensor intensity should be set lower.

Move stage to Moves the plate stage to the specified teachpoint:

• Stack release. The position to which the plate stage 
moves during a stack release operation.

• Stacker gripper offset. The distance (mm) above the 
Stacker grip teachpoint at which the plate stage 
stops for the grippers to grip the microplate.

• Orientation sensor offset. The distance (mm) the plate 
stage will move below the standard sensor 
teachpoint to detect the microplate when the 
Check orientation option is enabled.

• Presentation. The plate stage height (mm) above the 
home position at which a robot picks up or places 
a microplate on the plate stage. 

Note: This value is set in the Profiles tab.
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Current Display the current values (mm) for the following plate 
stage locations:

• Stacker gripper offset. Displays the current value, 
which you can edit.

• Orientation sensor offset. Displays the current value, 
which you can edit.

• Presentation. Displays the current value, which you 
can edit in the Profiles tab. 

New Offsets Calculates a new value based on the current location 
of the plate stage:

• Stacker gripper offset

• Orientation sensor offset

Orientation sensor 
thresholds

Max (notch)

Specifies the highest value that an orientation sensor 
can register when sensing a notch. Any sensor reading 
above this value indicates that a solid microplate wall 
is present. Any sensor value below this threshold 
indicates that either a notch, or no microplate is 
present.

Note: If the stacker does not sense a notch when it 
should, a “wrong plate type” or a “plate rotated 180 
degrees” error message appears. In this case, adjust 
the sensor threshold value.

Orientation sensor 
thresholds

Min (plate)

Specifies the lowest value that an orientation sensor 
can register and still consider a notch to be present.

If the orientation sensor returns a value below this 
threshold, an error message appears stating that no 
microplate is present on the stage.

Note: If the stacker does not sense a notch when it 
should, a “wrong plate type” or a “plate rotated 180 
degrees” error message appears. In this case, adjust 
the sensor threshold value.

Apply & save 
labware parameters

Saves any changes to the labware parameters.

Property or command Description
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Operations area

Stage Position area

Sensors area 

Selection or command Description

Load stack/
Release stack

Loads or releases the stack of labware in the 
Stacker.

• Load stack. Moves the bottom microplate in the 
stack down onto the plate stage, where it is held 
on the sides by the rack’s stacker grippers. Locks 
the rack in place on the Stacker.

Note: The Labware Stacker will not operate 
until the rack is loaded.

• Release stack. Moves the bottom microplate up in 
the stack so that it rests on the rack’s stacker 
grippers, and the rack can be removed from the 
Stacker.

Note: Alternatively, you can press the load/release 
button on the Stacker instead of clicking Load stack 
or Release stack.

Downstack Moves the bottom microplate from the labware rack 
onto the plate stage. The rack remains held in place 
on the Stacker.

Upstack Moves a microplate from the plate stage into the 
labware rack. The rack remains held in place on the 
Stacker.

Home Moves the plate stage to its home position, and then 
to the Presentation teachpoint.

Selection or command Description

display Indicates the current location of the plate stage, 
measured as the distance (mm) from the home 
position, which is at the bottom of the plate stage 
travel. 

Up Moves the plate stage up in 1- mm increments.

Down Moves the plate stage down in 1- mm increments.

Sensor Description

Plate present A white number indicates that a microplate is in the 
grippers.

An orange number indicates that no microplate is 
present in the grippers.
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Gripper area

Top Panel Display Message 

Enables you set a text message that appears in the display on top of the 
Labware Stacker. 

Related information

Air (psi) Indicates the grip pressure (psi) when the grippers 
are closed.

A positive number indicates that the grippers are 
closed. When the grippers are open, the value is 
zero.

Notch sensors (left) Detects the presence of a notch in the left corner of 
microplate when the plate stage is at the Orientation 
Sensor teachpoint.

A white number indicates the absence of a notch. An 
orange number indicates the presence of a notch.

Notch sensors (right) Detects the presence of a notch in the right corner 
of the microplate when the plate stage is at the 
Orientation Sensor or Grip teachpoint. 

A white number indicates the absence of a notch. An 
orange number indicates the presence of a notch.

Rack present A white number indicates that a rack is loaded.

An orange number <20 indicates no rack is loaded.

Sensor Description

Selection or command Description

Open Opens the grippers.

Close Closes the grippers.

For more information about... See...

Opening diagnostics “Opening diagnostics software” on page 36

Stacker gripper offset “Adjusting the labware- specific gripper 
offset” on page 61

Configuring microplate 
orientation checking

“Setting up microplate orientation checking” 
on page 64

Profiles tab “Labware Stacker Diagnostics—Profiles tab” 
on page 90
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